1. PURPOSE: to describe the standardized laboratory protocol for molecular subtyping of Shiga toxin-producing *Escherichia coli* O157 (STEC O157).

2. SCOPE: to provide the PulseNet participants with a single protocol for performing MLVA of STEC O157, thus ensuring inter-laboratory comparability of the generated results.

3. DEFINITIONS:
   3.1 MLVA: Multiple-locus variable-number tandem repeat analysis
   3.2 VNTR: Variable-number tandem repeat
   3.3 DNA: Deoxyribonucleic acid
   3.4 DNase: Deoxyribonuclease
   3.5 PCR: Polymerase chain reaction
   3.6 HPLC: High purity liquid chromatography
   3.7 dNTP: Deoxyribonucleotide triphosphate
   3.8 CDC: Centers for Disease Control and Prevention
   3.9 SOP: Standard Operating Procedure

4. RESPONSIBILITIES/PROCEDURE
   4.1. Biosafety warning: STEC O157 with an infectious dose as low as 100 cells is a human pathogen capable of causing serious disease. Always use a minimum of Biosafety level 2 practices and extreme caution when transferring and handling strains of this serotype. Work in a biological safety cabinet when handling large amounts of cells. Disinfect or dispose of all plastic ware and glassware that come in contact with the cultures in a safe manner.

   4.2. Reagents, supplies and equipment needed for DNA template preparation
   4.2.1 Trypticase soy agar with 5% sheep blood (TSA-SB) or comparable media
   4.2.2 1 µl and 10 µl inoculation loops
   4.2.3 0.5 ml microcentrifuge tubes
   4.2.4 DNase-free, molecular biology-grade water
   4.2.5 Vortex
   4.2.6 Boiling water bath or thermocycler/thermal block accommodating 0.5 ml tubes
   4.2.7 Tabletop centrifuge for high rpm (up to 13,000-14,000 rpm) spinning
   4.2.8 Pipets (200 µl) for aliquoting 100 µl of DNase-free, molecular biology-grade water
   4.2.9 Filtered Sterile Pipet tips

   4.3. Reagents, supplies and equipment needed for PCR
   4.3.1 DNA lysates from isolates (keep at -20°C or -80°C freezer for long term)
   4.3.2 PCR primers (see appendix PNL28-1)
      4.3.2.1 Fluorescent-labeled forward primers
         4.3.2.1.1 HPLC-purified
      4.3.2.2 Unlabeled reverse primers
         4.3.2.2.1 Regular gel filtration purification
      4.3.2.3 Biosearch Technologies (Novato, CA; www.biosearchtech.com; 1-800-436-6631) sells primers labeled with the three dyes needed for the protocol
      4.3.2.4 Divide the concentrated stocks (100 µM) in portions and store at -80°C freezer
4.3.2.4.1 One vial should contain enough to prepare 25-50 µl of working solution. Avoid repetitive freeze-thaw cycles of concentrated primer stocks.

4.3.2.5 The 1.0, 2.5, 5.0 and 25.0 µM working solutions can be stored at either -20°C or -80°C freezer.

4.3.2.6 Prepare new working solutions every month or if a significant drop in the fluorescence level is observed (for instructions refer to PNQ06_MLVA ABI certification, appendix PNQ06-5).

4.3.3 96-well polypropylene PCR plates (Fisher, Cat. No. 07-200-613) or Microamp PCR tubes without caps (Life Technologies, Cat. No. N8010533).

4.3.4 8-well strip caps for the polypropylene plate (Fisher, Cat. No. 07-200-639) or MicroAmp strip caps for the individual tubes (Life Technologies, Cat. No. N8010535).

4.3.5 DNase-free, molecular biology-grade water.

4.3.6 1.5 ml Eppendorf microcentrifuge tubes.

4.3.7 PCR Nucleotide Mix (ready-to-use dNTP mix containing all four nucleotides; Roche, Cat. No. 11814362001).

4.3.8 Platinum Taq Polymerase with 50 mM MgCl2 and 10X buffer (Life Technologies, Cat. No. 10966-034).

4.3.9 PCR Cooling block (VWR International, Cat. No. 62111-762).

4.3.10 DNA Engine (Biorad), GeneAmp (Life Technologies) or similar thermocycler with a heated lid option and 96-well block format.

4.3.11 Parafilm M, 4” width (VWR, Cat. No. 52858-032).

4.3.12 Complete set (100 µl, 200 µl, 100 µl, 20 µl, 10 µl and 2 µl) of single channel pipettors for mastermix set-up (“clean set”).

4.3.13 1-10 µl single channel pipettor for adding DNA templates.

4.3.14 Filtered tips for pipettors.

4.3.15 Microfuge for low (up to 6,000 rpm) rpm spinning.

4.4. Reagents, supplies and equipment needed for Genetic Analyzer 3500

4.4.1 DNase-free, molecular biology-grade water.

4.4.2 PCR Cooling block (VWR International, Cat. No. 62111-762).

4.4.3 10 µl, 100 µl, and 1000 µl single channel pipettors.

4.4.4 10 µl and 200 µl multichannel pipettors.

4.4.5 Filtered pipette tips.

4.4.6 Sterile solution basins.

4.4.7 1.5 ml Eppendorf microcentrifuge tubes.

4.4.8 96-well polypropylene (non-PCR) V-bottom plate (for dilutions; Fisher Scientific, Cat. No. 07-200-698).

4.4.9 MicroAmp Optical 96-well reaction plates (Life Technologies, Cat. No. 4306737).

4.4.10 96-well plate base (Life Technologies, Cat. No. 4317237).

4.4.11 Rubber septa for 96-well reaction plates (Life Technologies, Cat. No. 4315933).

4.4.12 96-well plate retainer (Life Technologies, Cat. No. 4317241).

4.4.13 Hi-Di Formamide (Life Technologies, 25 ml Cat. No. 431320).

4.4.14 GeneFlo 625 DNA size standard—ROX, 800 µl (Chimerx, Cat. No. 3125-02).
4.4.15 Multi-Capillary DS-30 (Dye Set D) Matrix Standard Kit (Life Technologies, Cat. No. 4345827)

4.4.15.1 Needed to establish the system dye color spectra for the instrument. Required when analyzing fragments labeled with FAM, HEX, NED, and ROX.

4.4.15.2 **NOTE:** DS-33 Matrix Standard (Dye set G5, required for analyzing fragments labeled with FAM, VIC, NED, PET, and LIZ) is typically installed as default as part of the instrument installation process. The 3500 system will allow for installation of DS-30 only if DS-33 is already installed.

4.4.15.3 In order to install the DS-30 Matrix, follow the instructions of the kit insert and the “Getting Started Guide”, chapter “Performing a Spectral Calibration”

4.4.16 3500 24 Capillary Array 50 cm (Life Technologies, Cat. No. 4404689)

4.4.17 Genetic Analyzer Cathode Buffer Container (4 pack), 1X (Life Technologies, Cat. No. 4408256)

4.4.18 Genetic Analyzer Anode Buffer Container (4 pack), 1X (Life Technologies, Cat. No. 4393927)

4.4.19 3500 Conditioning Reagent (Life Technologies, Cat. No. 4393718)

4.4.20 3500 POP7 Performance Optimized Polymer, (384 samples) (Life Technologies, Cat. No. 4393708)

4.4.21 Parafilm M, 4” width (VWR, Cat. No. 52858-032)

4.4.22 Centrifuge with a microtiter plate rotor

4.4.23 Heating block or thermal cycler accommodating a 96-well plate for denaturation

4.4.24 Microfuge for low (up to 6,000 rpm) rpm spinning

4.5. Isolate preparation

4.5.1 **Day 0:**

4.5.1.1 Streak an isolated colony from test cultures to TSA-SB plate (or comparable media). Incubate cultures at 37ºC for 14-18 hrs.

4.5.2 **Day 1:**

4.5.2.1 For each isolate to be typed, aliquot 100 µl of sterile, molecular biology-grade water into 0.5 ml microfuge tubes. Use a sterile, disposable 1 µl loop to pick 2-3 colonies (about half of a loopful); rotate the loop in the microfuge tube to release the bacteria into the water. Cap and vortex for 10-15 seconds to disperse any clumps.

4.5.2.2 Place the tubes in a 100ºC water bath or heat block for 10 minutes. Cool briefly on ice or in fridge and centrifuge for 10 minutes at 10,000 rpm. Place on ice or in fridge while preparing PCR reactions. These DNA templates can be stored at -20ºC or -80ºC for several years.

4.6. PCR procedure

4.6.1 **Day 1:**

4.6.1.1 Fill out, save with the run name, and print a PCR template worksheet (see appendix PNL28-2) with appropriately labeled samples (a maximum of 46 isolates/plate; 44 unknowns + two positive controls and a negative control; two wells are reserved for the internal ladder).

4.6.1.1.1 For each isolate, two wells must be labeled as follows: “BNkeyR1” where “BNkey” represents the isolate-specific state laboratory identification
number (be sure to use the exactly same isolate ID that is used in the PFGE gels uploaded to the national database) and “R1” represents one of the two specific multiplex PCR reactions (R1, R2).

4.6.1.2 Fill out, and print a PCR mastermix calculation worksheet (see appendix PNL28-3) by typing the number of isolates to be tested (plus 2-3 extra) in the PCR mastermix calculators labeled R1 and R2. This number is highlighted in RED and is next to “number of samples to be analyzed”. The mastermixes for reactions 1 and 2 (R1, R2) for one sample are as follows:

<table>
<thead>
<tr>
<th>R1</th>
<th>Volume (µl)</th>
<th>Final conc.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCR water</td>
<td>5.30</td>
<td></td>
</tr>
<tr>
<td>PCR buffer (10x)</td>
<td>1.00</td>
<td>1x</td>
</tr>
<tr>
<td>MgCl₂ (50 mM)</td>
<td>0.40</td>
<td>2.00 mM</td>
</tr>
<tr>
<td>dNTPs (10 mM)</td>
<td>0.20</td>
<td>0.20 mM</td>
</tr>
<tr>
<td>VNTR-3F (25 µM)</td>
<td>0.27</td>
<td>0.67 µM</td>
</tr>
<tr>
<td>VNTR-3R (25 µM)</td>
<td>0.27</td>
<td>0.67 µM</td>
</tr>
<tr>
<td>VNTR-34F (5 µM)</td>
<td>0.24</td>
<td>0.12 µM</td>
</tr>
<tr>
<td>VNTR-34R (5 µM)</td>
<td>0.24</td>
<td>0.12 µM</td>
</tr>
<tr>
<td>VNTR-9F (5 µM)</td>
<td>0.24</td>
<td>0.12 µM</td>
</tr>
<tr>
<td>VNTR-9R (5 µM)</td>
<td>0.24</td>
<td>0.12 µM</td>
</tr>
<tr>
<td>VNTR-25F (2.5 µM)</td>
<td>0.20</td>
<td>0.05 µM</td>
</tr>
<tr>
<td>VNTR-25R (2.5 µM)</td>
<td>0.20</td>
<td>0.05 µM</td>
</tr>
<tr>
<td>Taq (5 U/µl)</td>
<td>0.20</td>
<td>1 U</td>
</tr>
</tbody>
</table>

= 9.00

<table>
<thead>
<tr>
<th>R2</th>
<th>Volume (µl)</th>
<th>Final conc.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCR water</td>
<td>5.92</td>
<td></td>
</tr>
<tr>
<td>PCR buffer (10x)</td>
<td>1.00</td>
<td>1x</td>
</tr>
<tr>
<td>MgCl₂ (50 mM)</td>
<td>0.40</td>
<td>2.00 mM</td>
</tr>
<tr>
<td>dNTPs (10 mM)</td>
<td>0.20</td>
<td>0.20 mM</td>
</tr>
<tr>
<td>VNTR-17F (5 µM)</td>
<td>0.30</td>
<td>0.15 µM</td>
</tr>
<tr>
<td>VNTR-17R (5 µM)</td>
<td>0.30</td>
<td>0.15 µM</td>
</tr>
<tr>
<td>VNTR-19F (1 µM)</td>
<td>0.16</td>
<td>0.016 µM</td>
</tr>
<tr>
<td>VNTR-19R (1 µM)</td>
<td>0.16</td>
<td>0.016 µM</td>
</tr>
<tr>
<td>VNTR-36F (1 µM)</td>
<td>0.11</td>
<td>0.011 µM</td>
</tr>
<tr>
<td>VNTR-36R (1 µM)</td>
<td>0.11</td>
<td>0.011 µM</td>
</tr>
<tr>
<td>VNTR-37F (2.5 µM)</td>
<td>0.07</td>
<td>0.017 µM</td>
</tr>
<tr>
<td>VNTR-37R (2.5 µM)</td>
<td>0.07</td>
<td>0.017 µM</td>
</tr>
<tr>
<td>Taq (5 U/µl)</td>
<td>0.20</td>
<td>1 U</td>
</tr>
</tbody>
</table>

= 9.00

4.6.1.2.1. **NOTE:** these primer concentrations serve as a starting point. Since laboratory-specific factors, such as the age of the primer stocks, calibration status of the thermocyclers and pipettes, etc., affect amplification efficiency, each laboratory will have to re-optimize the primer
concentrations for optimal detection of all targets. However, any other parameters stated in the SOP should not be changed.

4.6.1.3 Thaw all reagents and supplies needed for PCR reactions and place on ice; keep primers light protected as much as possible.

4.6.1.3.1 **NOTE:** PCR mastermixes should be set up in a clean hood that is dedicated just for this purpose and where no cultures or DNA are handled.

4.6.1.4 Prepare the two separate PCR mastermixes in 1.5 ml Eppendorf tubes following the instructions in the PCR mastermix calculation worksheet (see appendix PNL28-3). Keep the mastermix on ice while preparing. Add the mastermix components in the following order: water, 10x PCR buffer, MgCl₂, dNTPs, primers, and then finally Taq polymerase. Mix the reaction mixture by vortexing briefly.

4.6.1.4.1 **NOTE:** All components except Taq polymerase should be vortexed thoroughly before adding to the mastermix. Taq may be briefly centrifuged with low rpm, if necessary, to pull the enzyme down to the bottom of the tube.

4.6.1.5 Place a 96-well PCR plate or required number of PCR tubes in a PCR cooling block.

4.6.1.6 Dispense 9.0 µl of each mastermix into the appropriate rows of the 96-well polypetene plate / PCR tubes as noted in the PCR template worksheet (see appendix PNL28-2).

4.6.1.7 Add 1 µl of PCR water to each of the two different wells representing the negative controls of the two reactions.

4.6.1.8 Add 1.0 µl of DNA lysate to each of the two different wells representing the two PCR reactions. Use STEC O157 strain EDL933 (ATCC 43895) as a positive control (it is recommended to run the positive control as a duplicate). The internal ladder to be used will be comprised of pooled PCR products of the isolates EC04PN0139 and EC04PN0570 (see appendix PNL28-4 for instructions for ladder preparation).

4.6.1.9 Cover all wells / tubes with 8-well strip caps and firmly clamp down to avoid any evaporation during PCR amplification.

4.6.1.10 Recommendation: briefly spin down the plate / tubes to remove any air bubbles.

4.6.1.11 Setup the following PCR parameters and save the program as “O157MLVA”:

\[
\begin{align*}
* \text{95ºC for 5 min} & \quad \text{Step 1} \\
* \text{94ºC for 20 sec} & \quad \text{Step 2} \\
* \text{65ºC for 20 sec} & \quad \text{Step 3} \\
* \text{72ºC for 20 sec} & \quad \text{Step 4} \\
* & \quad \text{Go to step 2, 34x} \\
* \text{72ºC for 5 min} & \quad \text{Step 5} \\
* & \quad \text{Step 6} \\
* & \quad \text{Indefinite hold at 4ºC} \\
\end{align*}
\]
4.6.1.11.1 NOTE: Make sure to use the heated lid option on the PCR block and tube (calculated) temperature control

4.6.1.12 When the PCR is complete store the amplification products light-protected at 4°C until ready to run on the sequencer. If the fragment analysis is not performed the same day, the plate should be stored at -20°C or -80°C. The PCR products are stable for approximately one month, when stored frozen.

4.7 Initial setup of Genetic Analyzer 3500 instrument before the first run:
NOTE: step 4.7 only needs to be performed before the very first run. In future runs continue directly to step 4.8.

4.7.1 Click on the “3500” icon to open the 3500 Data Collection Software. The software will open a window and the main screen will display the “Dashboard”. If the connections are functioning properly, the status light on the sequencer will be green, the “State” of the instrument will be “Idle”, and all of the consumables should have the number of days/samples remaining for each item.

4.7.2 Setting up the Size Standard
4.7.2.1 Click on the “Library” icon at the top right of the screen.
4.7.2.2 At the left-hand side of the screen select the “Size Standards” menu option.
4.7.2.3 At the top of this screen select “Create” in the toolbar
4.7.2.4 A new window will appear and in the box next to “Size Standard” enter in “GeneFlo625”
4.7.2.5 From the “Dye Color” drop-down menu select “Red”
4.7.2.6 In the “Enter new Size Standard definition” box enter the fragment sizes for each peak (refer to the GeneFlo 625 product insert for the peak sizes). Separate each size using a comma.
4.7.2.7 When finished, click the “Add Size(s)” button, then click “Save” and “Close”

4.7.3 Setting up Run Parameters:
4.7.3.1 Once the fragment sizes have been assigned the Assays, File Name Conventions, and Results Group will need to be set up.

4.7.3.1.1 Assays
4.7.3.1.1.1 At the left-hand side of the screen select the “Assays” menu option and click “Create” in the toolbar at the top of the screen
4.7.3.1.1.2 For “Assay Name” enter “O157_Fragtest” and from the “Application Type” drop-down menu select “Fragment”. Under the “Protocols” heading make sure “No” is selected for assigning multiple instrument protocols.
4.7.3.1.1.3 Next to “Instrument Protocol” select the “Create New” button. A new window will appear.
4.7.3.1.1.3.1 From the “Dye Set” drop-down menu select “DS-30”
4.7.3.1.1.3.2 For “Run Module” select “FragmentAnalysis50_POP7xl”
4.7.3.1.1.3.3 An alert window will pop up asking if you would wish to assign a protocol name. Click “Yes” and next to “Protocol Name” replace the ‘_1’ with ‘_2’ (i.e. - FragmentAnalysis50_POP7xl_2). Use the default values for all other parameters. This will create a new protocol with the specified criterion.
4.7.3.1.1.3.3.1 **NOTE:** These are the instrument default running conditions for Fragment Analysis with a 50 cm capillary array and POP7 polymer. You can check the running conditions by clicking the “Library” button at the top right of the dashboard and then selecting the “Assays” menu option on the left-hand side of the screen. The default conditions are:

- Oven_Temperature: 60°C
- PreRun_Voltage: 15.0 kVolts
- Pre-Run-Time: 180 sec.
- Injection_Voltage: 1.6 kVolts
- Injection_Time: 15 sec.
- Data_Delay_Time: 1 sec.
- Run_Voltage: 19.5 kVolts
- Run time: 1330 sec.

4.7.3.1.1.3.4 When finished, click on “Save to Library” and click “Yes” in the pop-up window that asks to apply the changes to the assay. Click “OK” to confirm, and then close this window.

4.7.3.1.1.4 Next to the “Sizecalling Protocol” option select the “Create New” button.

4.7.3.1.1.4.1 In the new window enter “O157MLVA” as the “Protocol Name”.

4.7.3.1.1.4.2 From the “Size Standard” drop-down menu select “GeneFlo625”

4.7.3.1.1.4.3 Input the following analysis settings:

- Analysis: Full Range
- Sizing: Partial Sizing
- Start Size: 50
- Stop Size 625
- Size Calling Method: Local Southern Method
- Primer Peak: Present
- Minimum Peak Height:
  - Blue: 600
  - Green: 600
  - Yellow: 600
  - Red: 20
  - Uncheck Purple and Orange
- Smoothing: none
- Baseline window: 51 pts
- Min. Peak Half Width: 2 pts
- Peak Window Size: 21 pts
- Polynomial Degree: 2
- Slope Threshold Peak Start: 0.0
- Slope Threshold Peak End: 0.0

4.7.3.1.1.4.4 Click on “Save to Library” and “Yes” to apply to the assay. Select “OK” to confirm and close this window when finished.

4.7.3.1.1.5 Once all protocols have been established for the new assay, click “Save” and close the window to return to the “Library” main screen.
4.7.3.1.2 File Name Conventions
4.7.3.1.2.1 Access the “File Name Conventions” menu on the left-hand side of the screen. In the toolbar at the top of the screen select “Create”.
4.7.3.1.2.2 In the window that appears enter “MLVA” next to “Name”.
4.7.3.1.2.3 Use the default settings and click “Save” and close the window.

4.7.3.1.3 Results Groups
4.7.3.1.3.1 Access the “Results Groups” menu on the left-hand side of the screen. In the toolbar at the top of the screen select “Create”.
4.7.3.1.3.2 In the window that appears, enter “O157results” as the name for this results group.
4.7.3.1.3.3 Under the “Delimiters” section heading click the “Add” button to insert a dash in the “Selected Attributes” box on the right-hand side of the window.
4.7.3.1.3.4 From the “Available Attributes” list, scroll down to “Plate Name”. Select it and click the “Add” button in between the two boxes to add it to the “Selected Attributes” list.
4.7.3.1.3.5 Uncheck the “Include an Instrument Run Name folder” and “Include an Injection folder” options, keeping all other default parameters.
4.7.3.1.3.6 Save this results group to the library and close the window.

4.8 Genetic Analyzer 3500 instrument preparation before each run
4.8.1 Day 1
4.8.1.1 Make sure the service console is open and the status light on the sequencer is green. Make sure a capillary array is installed in the instrument. For installation, follow the instructions of the “Install Capillary Array” wizard. You can find the wizards by clicking on the “Maintenance” option in the toolbar at the top right of the screen and then clicking on the “Maintenance Wizards” menu option in the left-hand panel. Before setting up a run check to make sure that the consumables are not expired.
4.8.1.1.1 NOTE: The RFID tags on the packaging of the consumables automatically log in the hours spent on the instrument. The run will not start with expired reagents with the exception of an expired polymer.
4.8.1.2 Go back to the dashboard screen by clicking the “Dashboard” button at the top left of the screen.
4.8.1.3 Select the “Create New Plate” icon at the top of the screen. Name the run following the standardized PulseNet naming system: use the unique identifier code that was assigned to your laboratory by PulseNet for the first two to four letters of the file name. The next two spaces will indicate the year and the next four spaces will indicate the month and the date the run was performed. For example GA070426 is a run made at the GA Public Health Laboratory on April 26, 2007. If several runs are performed the same day, separate the file names by using sequential numbers, for example GA070426-1, GA070426-2.
4.8.1.4 From the “Plate Type” drop-down menu, select “Fragment”.
4.8.1.5 Type in the Owner name or initials.
4.8.1.6 Use the default settings (50cm array, POP-7 polymer) for the rest of the options and click on the “Assign Plate Contents” button at the bottom of the screen.

4.8.1.7 The plate view screen will appear.

4.8.1.8 Here you can type in the sample IDs or import a sample plate file from a template (see Appendix PNL28-5 for instructions on importing plate .txt files).

4.8.1.9 To assign the Assay to the plate, proceed as follows:

4.8.1.9.1 Click on “Add from Library” in the “Assays” box at the bottom of the screen.

4.8.1.9.2 In the new window select “O157_Fragtest” from the list of assays.

4.8.1.9.3 Add this assay by clicking on the “Add to Plate” button, and then close the window.

4.8.1.10 Adding the File Name Conventions (MLVA) and Results Groups (O157results) can be done in the same manner, by selecting the “Add from Library” link in the respective boxes.

4.8.1.11 Once the assay, file name convention and results group have been added to the plate, select the entire sample ID set by highlighting the individual cells or by clicking on column/row headings.

4.8.1.12 Check the box next to each of the run parameters: Assay, File Name Convention, and Results Group.

4.8.1.13 When each of the run parameters have been successfully assigned a dot will appear in the center of the cells in which the parameters were applied.

4.8.1.13.1 NOTE: If a plate layout has been imported from a .txt file the Assay, File Name Convention and Results Group should automatically be applied to the plate and check-marked for all samples.

4.8.1.13.2 NOTE2: What identifiers are shown in the sample ID cells can be changed by selecting or deselecting options in the “Show In Wells” drop-down menu above the sample plate layout. Assays, file name conventions, and results groups can be color coded by double-clicking the black dot to the left of the file name or during initial setup.

4.8.1.14 Save the plate by clicking the “Save Plate” button in the toolbar at the top of the screen and selecting “Save” from the drop-down menu.

4.8.1.15 Go back to the dashboard screen by clicking the “Dashboard” button in the top left corner of the screen and continue with fragment analysis preparation.

4.8.1.16 If needed, install the POP7 polymer in the instrument.

4.8.1.16.1 Click on the “Maintenance” button in the toolbar at the top right of the window, and then select the “Maintenance Wizards” menu option on the left-hand side.

4.8.1.16.2 Follow the instructions of the “Replenish Polymer” wizard.

4.8.1.17 If needed, also install new anode and cathode buffer containers.

4.8.1.17.1 NOTE1: if an old polymer pouch (been on the instrument > 7 days) is switched to a new one follow the instructions of the “Wash Pump
and Channels” wizard instead. A conditioning pouch will be required for this process.

4.8.1.17.2 **NOTE2:** To update the system after new reagents have been installed, click the “Refresh” button under “Consumables Information” on the Dashboard.

4.9. Fragment analysis sample preparation

4.9.1 Day 1

4.9.1.1 Thaw the Hi-Di Formamide, the GeneFlo 625 DNA size standard and the internal ladder (see appendix PNL28-4) and place on ice.

4.9.1.1.1 **NOTE:** aliquot Hi-Di Formamide (500 µl / tube) and the size standard (50 µl / tube) in order to avoid frequent freeze-thaw cycles.

4.9.1.2 Prepare a 96-well V-bottom plate for diluting the PCR reactions. Using a 200 µl multichannel pipettor and a solution basin, dispense 19 µl of molecular-grade water in the required number of wells.

4.9.1.3 Remove the plate / tubes with the PCR reactions from the thermocycler. Briefly spin down the plate / tubes, if necessary. Use a 10 µl multichannel pipettor to transfer 1 µl of each PCR reaction directly across to the corresponding set of wells in the dilution plate. In order to avoid cross-contamination, remove the strip cap from just one column at a time and recap the column before opening the next one.

4.9.1.4 For the internal ladder, combine R1 and R2 PCR products from the four PCR reactions of both internal ladder isolates to end up with a total of 40 µl. Mix well by pipetting up and down a few times and add 3 µl of internal ladder in two wells.

4.9.1.5 Using a 200 µl multichannel pipettor, mix the dilutions by pipetting up and down a few times. Cover the plate with parafilm and put in the fridge or on ice.

4.9.1.6 Prepare a fragment analysis master mix containing DNA size standard and Hi-Di Formamide for the samples following the calculations indicated in the table below. The fragment analysis mastermix calculations can also be performed using the autocalculate box at the bottom of the PCR template worksheet (see appendix PNL28-2. Vortex briefly and place on ice.

<table>
<thead>
<tr>
<th>Reagents</th>
<th>Frag. anal. mastermix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hi-Di Formamide</td>
<td>8 µl x (# samples +3)=</td>
</tr>
<tr>
<td>GeneFlo 625 bp size standard</td>
<td>1 µl x (# samples +3)=</td>
</tr>
</tbody>
</table>

4.9.1.7 Place a MicroAmp Optical 96-well sample plate in a cold block. Aliquot 9 µl of the prepared fragment analysis mastermix to the required number of wells. Cover the plate loosely with Parafilm.

4.9.1.8 Using the 10 µl multichannel pipettor, add 1 µl of 1:20 diluted PCR reactions to the appropriate columns in the sample plate. Keep sliding the Parafilm sheet from column to column to keep track of the sample order.
4.9.1.9 Denaturate templates by heating the reaction plate uncovered in a thermocycler at 95°C for 3 min
4.9.1.10 While the templates denaturate, turn the oven of the 3500 on using the “Start Pre-Heat” button located on the middle, right-hand side of the dashboard. Make sure the set point is at 60°C.
4.9.1.11 Briefly spin down the sample plate to remove any air bubbles
4.9.1.12 Seal the plate with the rubber septa. Place the sample plate in a plate base. Snap the plate retainer onto the plate and the plate base.
4.9.1.13 Place the plate assembly and the buffer into the Genetic Analyzer 3500.
   4.9.1.13.1 Push the tray button at the front of the Genetic Analyzer 3500 to bring the autosampler to the forward position. Open the instrument door.
   4.9.1.13.2 Place the plate assembly on the autosampler in position A or B with the notched corner of the plate base facing you.
   4.9.1.13.3 Close the instrument door and wait for the green light to illuminate.
   4.9.1.13.4 Open the previously created plate setup by clicking the blue “Edit Existing Plate” button at the top of the dashboard screen.
   4.9.1.13.5 Select the plate to be run and click “Open”.
   4.9.1.13.6 Link the plate by clicking “Link Plate for Run” at the bottom of the screen
   4.9.1.13.7 A “Load Plate” pop-up window will verify that the plate has been successfully loaded. Click “OK”.
   4.9.1.13.8 The “Start Run” button at the bottom of the screen will become functional indicating that the run can be started. Click on this button and then click “OK” on the alert window. The run will start.

4.10. Viewing and exporting data from the Genetic Analyzer 3500
4.10.1 Day 2
4.10.1.1 NOTE: Steps 4.10.1.3 and 4.10.1.4 only need to be performed before the very first analysis.
4.10.1.2 Double-click on the shortcut icon for GeneMapper v4.1 and enter the appropriate password to access the software. The main menu window will open.
4.10.1.3 Set up the size standard:
   4.10.1.3.1 From the “Tools” drop-down menu, select “GeneMapper Manager”. A “GeneMapper Manager” window will open.
   4.10.1.3.2 Select the “Size Standards” tab
   4.10.1.3.3 Click on “New”, leave the default option “Basic or Advanced” selected and click “OK”. The “Size Standard Editor” window will appear.
   4.10.1.3.4 Name the new size standard “GeneFlo625”
   4.10.1.3.5 Leave the default option “Red” as “Size Standard Dye”
   4.10.1.3.6 Enter sizes for each peak in the table (refer to the GeneFlo 625 product insert for the peak sizes)
   4.10.1.3.7 When finished, click “OK”
4.10.1.4 Set up analysis method:
   4.10.1.4.1 From the “Tools” drop-down menu, select “GeneMapper Manager”. A “GeneMapper Manager” window will open.
   4.10.1.4.2 Select the “Analysis Methods” tab.
4.10.1.4.3 Click on “New”, leave the default option “Microsatellite” selected and click “OK”. The “Analysis Methods Editor” window will appear.

4.10.1.4.4 Name the new method “O157MLVA”. and click “OK”.

4.10.1.4.5 Highlight the new method name “O157MLVA” and click “Open”.

4.10.1.4.6 Select the “Peak Detector” tab and change “Peak Detection Algorithm” to “Advanced” from the drop-down menu.

4.10.1.4.7 Input the following analysis settings and click “OK” when finished:

* Analysis: Full Range
* Sizing: Partial Sizing
  * Start Size: 50
  * Stop Size 625
* Smoothing: none
* Baseline window: 51 pts
* Size Calling Method: Local Southern Method
* Peak Amplitude Thresholds:
  * B: 600
  * G: 600
  * Y: 600
  * R: 20
  * P: 50
  * O: 50
* Min. Peak Half Width: 2 pts
* Polynomial Degree: 2
* Peak Window Size: 21 pts
* Slope Threshold:
  * Peak Start: 0.0
  * Peak End: 0.0
* Leave the “Enable Normalization” option unchecked

4.10.1.4.8 Click “Done” to close the GeneMapper Manager window and return to the main screen.

4.10.1.5 From the “File” drop-down menu select “Add Samples to Project”

4.10.1.6 Find the folder containing the data file to be analyzed: My Computer → AB SW & DATA (D:) → Applied Biosystems → 3500 → Data → O157results-<PlateName>

4.10.1.7 Highlight the desired file(s) and click on “Add to List”. File(s) will appear in the window on the right. Click “Add” below the file list to return to the original screen.

4.10.1.8 Samples in the selected file(s) will be listed in a new window and the “Analyze” (play) button appears in green color in the toolbar indicating that the files are ready to be analyzed.

4.10.1.9 Select the size standard GeneFlo625 for the first sample, highlight the size standard column by selecting the heading, and select “Fill Down” from the “Edit” drop-down menu.
4.10.1.10 Select the analysis method O157MLVA for the first sample, highlight the analysis method column, and select “Fill Down” from the “Edit” drop-down menu.

4.10.1.11 Click on the “Play” icon.

4.10.1.12 Name the project with the run name (for example, “GA070426”) and click “OK”.

4.10.1.13 A successful analysis is indicated by green squares. Yellow triangles indicate problematic components (i.e. missing size standard peaks). Red circles indicate results fell below acceptable quality values. Samples with yellow or red circles in the SQ column should be selected for re-analysis.

4.10.1.13.1 To resolve failed analyses due to sub-optimal molecular marker peak profile (i.e. miscalling of peaks), select a row(s) with a yellow triangle or a red circle in the SQ column and click on the “Size Match Editor” icon on the toolbar. “Size Match Editor” view will appear.

4.10.1.13.2 Place the cursor near the X-axis to activate the magnifying lens, and then pull up (mouse left-click and hold) to zoom in a specific area to facilitate editing.

4.10.1.13.3 Left-click at the base of a peak to select. Right-click and select “Add”, “Delete”, or “Change”.

4.10.1.13.4 Select the correct molecular weight for the selected peak from the drop-down menu. Repeat this process for all other miscalled peaks. Click “OK” when finished.

4.10.1.13.5 After the size standard has been adjusted, click the “Play” button to re-analyze the data. After a successful analysis, the samples will have green squares under the SQ column. If the size standard cannot be adjusted, the reaction is considered a fragment analysis failure and must be re-run.

4.10.1.14 Check the fragment result data (the fluorescent peaks) for each well by highlighting the well ID and by clicking on the “Display Plots” icon on the toolbar.

4.10.1.14.1 Make sure that all eight VNTRs amplified in the EDL933 control and that the fragment sizes are within the range specified in the appendix PNL28-2 and record the fragment sizes on the PCR template worksheet.

4.10.1.14.2 The size calling for the internal ladder should also be within the range specified in the appendix PNL28-2 (or PNL28-4).


4.10.1.15 Export the peak file:

4.10.1.15.1 **NOTE:** the following columns should appear in the exported table in the following order from left to right: “Dye/Sample peak”, “Sample File Name”, “Marker”, “Allele”, “Size”, “Height”, “Area”, “Data point”. You can modify the format of the table by selecting “Table setting editor” from the “Tools” drop-down menu. Select the “Genotypes” tab and make sure that only the boxes for the following are checked: “Sample File Name”, “Marker”, “Dye”, “Allele”, “Size”, “Height”, “Peak Area”, and “Data point”. 

<table>
<thead>
<tr>
<th>VERSION:</th>
<th>REPLACED BY:</th>
<th>AUTHORIZED BY:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>13 of 21</td>
</tr>
</tbody>
</table>
4.10.1.15.2 **NOTE 2:** You can import the peak file also from the Data Collection Foundation software, but the file format is not correct; the “Allele” and “Marker” columns are missing and there are additional columns in the file. This file cannot be imported into BioNumerics without first manually modifying (adding and deleting appropriate columns) the file.

4.10.1.15.3 Highlight the samples for which you want to export peak data.

4.10.1.15.4 Click on the “Display Plots” icon on the toolbar.

4.10.1.15.5 Click on the “Sizing Table” icon on the toolbar and a table will appear below the electropherograms.

4.10.1.15.6 From the “File” drop-down menu, select “Export Table”.

4.10.1.15.7 Select the location (for example a flash drive) where you want to export the data.

4.10.1.15.8 Name the export file with the run name (for example GA070426) and make sure the file type is tab-delimited text (.txt) file.

4.10.1.16 The remaining gel can stay in the instrument if it is going to be used within 7 days.

5. FLOW CHART:

6. REFERENCES:


7. CONTACTS:

   7.1 Eija Trees, D.V.M., Ph.D.
PulseNet Next Generation Subtyping Methods Unit, CDC
(404) 639-3672
EHyytia-Trees@cdc.gov

   7.2 Patti Lafon
PulseNet Next Generation Subtyping Methods Unit, CDC
(404) 639-2828
PLafon@cdc.gov

   7.3 Ashley Sabol
PulseNet Next Generation Subtyping Methods Unit, CDC
(404) 639-2947
ASabol@cdc.gov
8. AMENDMENTS:
5/6/2013: former appendix PNL28-4 (BioNumerics specifications for the *E. coli* O157 VNTR loci) was moved to SOP PND16 (PulseNet standard operating procedure for analysis of MLVA data of Shiga toxin-producing *Escherichia coli* in BioNumerics – Applied Biosystems Genetic Analyzer 3130/3500 data). Former appendices PNL28-5 and PNL28-6 were renamed PNL28-4 and PNL28-5, respectively.
### STEC O157 MLVA PCR Primers

<table>
<thead>
<tr>
<th>Locus</th>
<th>Dye</th>
<th>Forward Primer (5’ to 3’)</th>
<th>Reverse Primer (5’ to 3’)</th>
</tr>
</thead>
<tbody>
<tr>
<td>R1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VNTR-3</td>
<td>CalRed590</td>
<td>GG CGG TAA GGA CAA CGG GGT GTT TGA ATT G</td>
<td>GAA CAA CCT AAA ACC CGC CTC GCC ATC G</td>
</tr>
<tr>
<td>VNTR-34</td>
<td>FAM</td>
<td>GA CAA GGT TCT GGC GTG TTA CCA ACG G</td>
<td>GTT ACA ACT CAC CTG CGA ATT TTT TAA GTC CC</td>
</tr>
<tr>
<td>VNTR-9</td>
<td>FAM</td>
<td>GC GCT GGT TTA GCC ATC GCC TTC TTC C</td>
<td>GTG TCA GGT GAG CTA CAG CCC GCT TAC GCT C</td>
</tr>
<tr>
<td>VNTR-25</td>
<td>HEX</td>
<td>GC CGG AGG AGG GTG ATG AGC GGT TAT ATT TAG TG</td>
<td>GCG CTG AAA AGA CAT TCT CTG TTT GGT TTA CAC GAC</td>
</tr>
<tr>
<td>R2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VNTR-17</td>
<td>CalRed590</td>
<td>GC AGT TGC TCG GTT TTA ACA TTG CAG TGA TGA</td>
<td>GGA AAT GGT TTA CAT GAG TTT GAC GAT GGC GAT C</td>
</tr>
<tr>
<td>VNTR-19</td>
<td>FAM</td>
<td>GC AGT GAT CAT TAT TAG CAC CCC TTT CTG GAT GTT C</td>
<td>GGG GCA GGG AAT AAG GCC ACC TGT TAA GC</td>
</tr>
<tr>
<td>VNTR-36</td>
<td>FAM</td>
<td>GC CGT CCT TCA TCG GCC TGT CCC TTA AAC</td>
<td>GCC GCT GAA AGC CCA CAC CAT GC</td>
</tr>
<tr>
<td>VNTR-37</td>
<td>HEX</td>
<td>GC CGC CCC TT A CAT TAC GCG GAC ATT C</td>
<td>GCA GGA GAA CAA AAC AGA CAG TAA TCA GAG CAG C</td>
</tr>
</tbody>
</table>

1 Primer sets are listed as multiplex PCR cocktails.
### STEC O157 MLVA PCR template and ABI worksheet

<p>| | | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
<td>F</td>
<td>G</td>
<td>H</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Appendix PNL28-2**

<table>
<thead>
<tr>
<th>PCR run date:</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PCR instrument:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ABI run date:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ABI instrument:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**L. coli O157 - Positive Control (EDL933)**

<table>
<thead>
<tr>
<th>VNTR.25</th>
<th>VNTR.17</th>
</tr>
</thead>
<tbody>
<tr>
<td>127 - 128</td>
<td>138 - 140</td>
</tr>
<tr>
<td>153 - 155</td>
<td>173 - 179</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>VNTR.36</th>
<th>VNTR.37</th>
</tr>
</thead>
<tbody>
<tr>
<td>153 - 179</td>
<td>199 - 209</td>
</tr>
</tbody>
</table>

- **L. coli O157 - Internal Ladder fragment sizes**
  - **Expected Size Ranges**
    - **Fragment Sizes**
      - VNTR.25: 127 - 128, 138 - 140
      - VNTR.17: 153 - 155, 173 - 179
      - VNTR.36: 153 - 179
      - VNTR.37: 199 - 209
      - VNTR.34: 223 - 224, 260 - 262
      - VNTR.19: 297 - 298, 320 - 322
      - VNTR.3: 397 - 401, 435 - 435
      - VNTR.9: 520 - 522, 566 - 569

1. For each isolate, fill in an appropriate BioNumerics key number for PCR reactions R1 and R2 (for example: for an isolate CDC_K1720 the BioNumerics key numbers are CDC.K1720R.1 and CDC_K1720R.2).
2. Fill in the exact number of fragment analysis reactions (2 per isolate + controls) in the red box (extra already included in calculation). Mix the Hi-Di Formamide and 625 bp size standard in an appropriate tube. Add 9 μl of mixture to each well.
3. Using a multichannel pipettor, add 1 μl of 1:20 diluted PCR reaction to wells containing the Formamide/625 bp mixture.
4. Denature the plate at 95°C for 3 min.
5. Briefly spin down the plate.
6. Place the plate in the plate base; cover wells with a rubber septa; finish the plate assembly by snapping on the plate retainer.
**PCR Mastermix calculations**

**Appendix PNL.28-3**

Type in the number of reactions (+ 1 extra), currently a red one, next to "Number to analyze" for autoscalings.

<table>
<thead>
<tr>
<th>Number of samples to be analyzed</th>
<th>Total Reaction Volume</th>
</tr>
</thead>
</table>

**E. coli multiplex PCR R1**

<table>
<thead>
<tr>
<th></th>
<th>Lane 1</th>
<th>Lane 2</th>
<th>Lane 3</th>
<th>Lane 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCR Buffer</td>
<td>25 µl</td>
<td>25 µl</td>
<td>25 µl</td>
<td></td>
</tr>
<tr>
<td>MgCl2</td>
<td>1 µl</td>
<td>1 µl</td>
<td>1 µl</td>
<td></td>
</tr>
<tr>
<td>dNTPs</td>
<td>0 µl</td>
<td>0 µl</td>
<td>0 µl</td>
<td></td>
</tr>
<tr>
<td>Magnesium</td>
<td>0 µl</td>
<td>0 µl</td>
<td>0 µl</td>
<td></td>
</tr>
<tr>
<td>PCR Water</td>
<td>9 µl</td>
<td>9 µl</td>
<td>9 µl</td>
<td></td>
</tr>
</tbody>
</table>

**E. coli multiplex PCR R2**

<table>
<thead>
<tr>
<th></th>
<th>Lane 1</th>
<th>Lane 2</th>
<th>Lane 3</th>
<th>Lane 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCR Buffer</td>
<td>25 µl</td>
<td>25 µl</td>
<td>25 µl</td>
<td>25 µl</td>
</tr>
<tr>
<td>MgCl2</td>
<td>1 µl</td>
<td>1 µl</td>
<td>1 µl</td>
<td>1 µl</td>
</tr>
<tr>
<td>dNTPs</td>
<td>0 µl</td>
<td>0 µl</td>
<td>0 µl</td>
<td>0 µl</td>
</tr>
<tr>
<td>Magnesium</td>
<td>0 µl</td>
<td>0 µl</td>
<td>0 µl</td>
<td>0 µl</td>
</tr>
<tr>
<td>PCR Water</td>
<td>9 µl</td>
<td>9 µl</td>
<td>9 µl</td>
<td>9 µl</td>
</tr>
</tbody>
</table>
Appendix PNL28-4

Instructions to Prepare the Internal Ladder

1. Prepare DNA templates from isolates EC04PN0139 and EC04PN0570 as described in the protocol step 4.5. Store the templates at -20°C or -80°C freezer.
2. Use the DNA templates to set up and run the PCR reactions R1 and R2 as described in the protocol step 4.6.
3. After the PCR amplification, pool the R1 and R2 reactions for isolates EC04PN0139 and EC04PN0570 into one single PCR tube to end up with a final volume of 40 µl. Mix by pipetting up and down a few times.
4. New lot of internal standard must be tested against the old standard lot by running them in the same fragment analysis run.
5. Store the ladder in -20°C or -80°C freezer. It should remain stable at least 5-6 freeze-thaw cycles for a period of one month.

Expected fragment sizes (bp) of the fifteen fragments present in the internal ladder 139-570 as listed in the peak file:

- **VNTR-36 (B):** 170 - 172
- **VNTR-34 (B):** 222 - 224, 260 - 262
- **VNTR-19 (B):** 297 - 298, 320 - 322
- **VNTR-9 (B):** 520 - 522, 566 - 569
- **VNTR-25 (G):** 127 - 128, 138 – 140
- **VNTR-37 (G):** 193 - 194, 199 - 200
- **VNTR-17 (Y):** 153 - 155, 177 - 179
- **VNTR-3 (Y):** 397 - 401, 433 - 435

Expected fragment sizes (bp) of the fifteen fragments present in the internal ladder 139-570 as they appear in the electropherogram:

- **VNTR-25 (G):** 127 - 128, 138 – 140
- **VNTR-17 (Y):** 153 - 155, 177 - 179
- **VNTR-36 (B):** 170 - 172
- **VNTR-37 (G):** 193 - 194, 199 - 200
- **VNTR-34 (B):** 222 - 224, 260 - 262
- **VNTR-19 (B):** 297 - 298, 320 - 322
- **VNTR-3 (Y):** 397 - 401, 433 - 435
- **VNTR-9 (B):** 520 - 522, 566 - 569

**NOTE:** fragment sizes for the internal ladder 139-570 based on multiple independent runs at CDC and PulseNet Participating Laboratories
Appendix PNL28-5

Steps for Exporting and Importing Plate Set ups on the ABI 3500

Note: the procedure described below will require the sequencer computer to have Microsoft Office. If the sequencer computer does not have Microsoft Office, the exported file needs to be saved on a flash drive so that steps 10 through 16 can be performed on a computer with Microsoft Office.

1. On the Dashboard screen click on the “Edit Existing Plate” button.
2. Select “Fragment” from the “Filter” drop-down menu.
3. Find the most recent full plate. Click on the ID to highlight the desired plate and then click the “Open” button at the bottom of the window.
   3.1. NOTE: If you do not have a full plate, create a new one by filling in each sample ID space (A01 through H12) with “test” and saving it with the plate name “EC_Template”. Be sure to add the results group “O157results”, file name convention “MLVA”, and Assay “O157_Fragtest” to each sample, making sure each one is check-marked. It is necessary to have all required wells filled in when exporting so that they will be available in your exported file.
4. In the plate layout window, click the “Export…” button in the toolbar at the top of the screen.
5. In the export window, create a new folder on the desktop by clicking the “Desktop” icon on the left side of the window. Find the ‘New Folder’ button in the toolbar at the top of the window and name the new folder “MLVA Plate Setup”.
6. Save the file to this folder by using your new plate name (e.g. - CDC110726) and clicking “Save”.
7. A window will pop up letting you know that the plate has been successfully exported. Click “OK”.
8. Click the “Close Plate” button in the toolbar at the top of the plate layout screen, and click “Yes” to close without saving changes.
9. Minimize the 3500 program window and open the “MLVA Plate Setup” folder on the desktop.
10. Right-click your plate name, select “Open With” and in the submenu select Microsoft Office Excel.
11. Sample IDs can be typed or copy and pasted from a separate Excel file into the spaces next to the correct wells under the “Sample Name” heading.
   11.1. NOTE: Do not change/delete any of the column headings. The fields must be in the same format when importing as they were when exported. Additionally, the software will not import the file if the sample IDs contain special characters (e.g. - !, /, ) , etc). You can use underscores and dashes.
12. The “Plate Name” should be changed to match the plate/file name, and initials should be placed under the ‘Owner Name’ heading. The defaults for “Application Type”, “Capillary Length (cm)”, “Polymer”, and “Number of Wells” should be used.
13. Once all of the IDs are inserted, make sure that for each sample ID and all controls, the assay is “O157_Fragtest”, the results group name is “O157results”, the file name convention is “MLVA”, and “Sample” is listed under “Sample Type”.
14. Under the “File” drop-down menu select “Save”.
15. A warning window will appear asking if the workbook should be saved in the “Text (tab-delimited)” format. Click “Yes”.
16. Exit Microsoft Excel, clicking “No” when prompted to save changes.
   16.1. NOTE: The removal of additional spaces from lines in the .txt file after modification in Excel may be necessary before importing into the “3500” program. To do this, open the file in “Notepad” making
sure the window is opened in full screen. In lines 1, 2, and 4 remove any additional spaces after the last character in the line or from the left side of the page. Once all spaces have been removed from those lines, save the file by clicking “Save” in the “File” drop-down menu and close the window.

17. Go to the ABI 3500 plate layout window by clicking “Create New Plate” on the Dashboard.
18. Enter in the name of the plate and from the “Plate Type” drop-down menu select “Fragment”.
19. Click on the “Assign Plate Contents” button at the bottom of the screen.
20. In the toolbar at the top of the “Plate View” screen, click the “Import...” button.
21. In the import window, navigate to the recently created plate under Desktop/MLVA Plate Setup. Select the appropriate .txt file and click “Open”.
21.1. At this point an error message may appear asking if you would like to proceed. If you encounter this message, click the “Proceed” button at the bottom of the window.
22. When the file has been imported, an alert window will appear stating that the plate “has been successfully imported”. Click “OK”.
23. In the toolbar at the top of the screen click on “Save Plate” and from the drop-down menu select “Save As”. Enter the plate name matching the name of the .txt file, and click “OK”.

23.1. **NOTE:** When importing a plate layout from a .txt file the Assay, File Name Convention and Results Group should automatically be applied to the plate and check-marked for all samples. If the .txt file does not contain the correct assay file name (e.g. – the name is misspelled, etc.), the assay will not be imported and the file name convention and results group will be imported but not check-marked.

23.2. **NOTE2:** For repeated use, plate templates can be created by exporting a plate to the “MLVA Plate Setup” folder. Save the file as a tab-delimited text file with “test” as the sample ID and with a new plate name (e.g. - “EC_Template”). After you have filled out the information for a new run on the template, save it in step 14 with the standardized run name (name (e.g. - CDC101020). Since the Assay and Results Group are different for each MLVA assay (STECO157, Salmonella Typhimurium, Salmonella Enteritidis, etc), separate templates must be exported and saved accordingly.